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This tutorial illustrates a very common use of EDSMAC, that is, to perform a
time-distance study to evaluate accident avoidability. We’ll be able to watch
as the vehicles approach each other and determine the first point of
visibility between vehicles.
This tutorial is a continuation of the EDCRASH Tutorial, wherein the initial
vehicle velocities were estimated. You may wish to review that tutorial before
continuing.
Like all EDSMAC events, the procedure involves the following basic steps:





Create the vehicle(s)
Create the environment
Execute the EDSMAC event
Review the EDSMAC output reports

This basic procedure is described in detail in this tutorial.

It is assumed that HVE-2D is up and running, and
+ NOTE:
that the user is familiar with HVE-2Ds basic features,

such as using dialogs and viewers, as well as the
HVE-2D Editors. The purpose of this tutorial is to
illustrate those features while setting up and executing an
EDSMAC event.
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Getting Started

If you just finished the EDCRASH Tutorial, you
+ NOTE:
have already created your vehicles and environment and
may proceed directly to page 5-11, Creating the Events.
The same suggestion applies if you already did the
EDCRASH Tutorial and saved the case; if so, simply
open that case and skip to page 5-11.

As in other tutorials, before we get started with our current tutorial, let’s set the
user options so we’re all starting on the same page.

All options simply affect the appearance in a viewer
+ NOTE:
during Event or Playback mode.
Some of the following options are Toggles that
+ NOTE:
switch between two different modes. Make sure these
options are set correctly.

To set the initial user options, choose the following from the Options Menu:

â
â
â
â
â
â
â

ON: Show Key Results
OFF: Show Axes
OFF: Show Velocity Vectors
ON: Show Skidmarks
OFF: Show Targets
ON: AutoPosition
Units equals S.I.

As well see when we create the environment, our
+ NOTE:
EDSMAC Tutorial takes place in Australia; thus, we
require metric units.

â Render Options:







Show Vehicles as Actual
Phong Render Method
Complexity equals Object
Render Quality equals 5
Texture Quality equals 1
Anti-aliasing equals 1

The remaining options will automatically initialize to their default conditions.
We’re now ready to proceed with the tutorial.
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Creating the Vehicles
Let’s add the vehicles to our case. The first vehicle is a white, 1996 Ford Escort
2-Door Hatchback; the second vehicle is a dark red 1995 Nissan Sentra 4-door
Sedan. Let’s add the first vehicle:

â If the Vehicle Editor is not the current editor, choose Vehicle
Mode. The Vehicle Editor is displayed.

â Click Add New Object. The Vehicle Information dialog is
displayed. The Vehicle Information dialog allows the user to
select the basic vehicle attributes according to Type, Make,
Model, Year and Body Style.

The Vehicle Information dialog also allows you to
+ NOTE:
edit the Driver Location, Engine Location, Number of Axles

and Drive Axle(s). These options are assigned default
values for each vehicle. For our tutorial, only driver location
must be edited.

â Using the option buttons, click each button to choose the

TUTORIAL

following vehicle from the database:
 Type = Passenger Car
 Make = Ford
 Model = Escort
 Year = 1991-1996
 Body Style = 2-Door Hatchback
 Driver Location = Right
â Click OK to add Ford Escort 2-Dr Hatchback to the Active
Vehicles list.
The Ford Escort is added to the case. Next, let’s add the Nissan Sentra.

â Click Add New Object. The Vehicle Information dialog is
displayed.

â Using the option buttons, click each button to choose the
following vehicle from the database:
Type = Passenger Car
Make = Nissan
 Model = Sentra
 Year = 1995-1999
 Body Style = 4-Door
 Driver Location = Right
â Click OK to add Nissan Sentra 4-Dr to the Active Vehicles list.



We now have the vehicles required for our study, as shown in Figure 5-1.
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Figure 5-1 Ford Escort 2-Dr Hatchback (above) and Nissan Sentra 4-Dr (below).
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Editing the Vehicles
Next, we’ll edit the vehicles to change their color and weight. In addition, we’ll
change the stiffness of the Nissan Sentra, using values derived from our initial
reconstruction analysis.
Start by changing the color of the Ford Escort:

â Select the Ford Escort 2-Dr Hatchback from the Active
Vehicles drop-down list, making it the current vehicle. The
Ford Escort is now displayed in the Vehicle Editor.

â Click on the CG and choose Color. The Vehicle Color dialog is
displayed (see Figure 5-2), showing the vehicle’s current color
(the small black square, or hot spot, in the color wheel) and
intensity (the arrow in the intensity slider). Click on the hot spot
and drag it to the center of the circle. To lighten the vehicle, click
on the intensity slider and drag it to the far right end.

+ NOTE: The color chip on the left shows the current color.
â When the color is to your liking, press the Close button to
apply the new vehicle color.

TUTORIAL

The vehicles apparent color may be slightly
+ NOTE:
misleading because the vehicle is translucent when

displayed in the Vehicle Editor. The actual color will be
used whenever the vehicle is displayed during Event and
Playback mode.

Figure 5-2 Vehicle Color
dialog, used for assigning the
vehicle color.
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Next, let’s change the Escort’s weight. Perform the following steps:

â Click on the CG and choose Inertias. The Inertias dialog is
displayed (see Figure 5-3), and we’re ready to change the
vehicle’s weight.

â In the Total Weight text field, replace the existing weight,
10283 Newtons, with the measured value, 11037 Newtons.

The weight is entered as a force (Newtons). Mass
+ NOTE:
units (kg) are calculated and displayed.
The dialog might display 10283.5, or similar
+ NOTE:
number because the weight is actually divided by the
current gravity constant and stored as mass. Extra
precision results when the mass is multiplied by the
current gravity constant and redisplayed.

â Press OK to accept the weight value.
The Ford Escort is now ready for use in our tutorial. Using the viewer thumb
wheels and/or manipulators, pan, zoom and look at the vehicle.

It is important to be able to manipulate (pan and
+ NOTE:
zoom) the objects in the current viewer. Refer to the
Users Manual (see Window Manager Basics) for more
information.

Figure 5-3 Vehicle Inertias dialog, used for editing the
current weight and yaw inertia.
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Now, let’s change the color, weight and stiffness of the Nissan Sentra:

â Click on Nissan Sentra 4-Dr in the Active Vehicles list,
making it the current vehicle. The Nissan Sentra is now
displayed in the Vehicle Editor.

â Click on the CG and choose Color. The Vehicle Color dialog is
displayed. The vehicle’s color is fine, but we need to darken it.
To darken the vehicle, click on the intensity slider and drag it to
the middle of the range.

+ NOTE: The color chip on the left shows the current color.
â When the color is to your liking, press the OK button to apply
the new vehicle color.
Next, let’s change the Nissan’s weight:

â Click on the CG and choose Inertias. The Inertias dialog is
displayed.

â In the Total Weight text field, replace the existing weight,
10858 Newtons, with the measured value, 11282 Newtons.

TUTORIAL

Again, the value displayed in the dialog may
+ NOTE:
contain extra precision, for reasons explained earlier.
â Press OK to accept the weight value.
Finally, let’s change the stiffness of the vehicle. From a previous
reconstruction analysis, the A and B stiffnesses were re-calculated in order
to balance the forces (the technique is described in references [20] and
[21]). Based on this analysis, a new KL stiffness was calculated.

â Click on the front side surface icon (red sphere). The CG to
Front dialog is displayed.

â Click Stiffness. The Stiffness Coefficients dialog for the front
surface is displayed, as shown in Figure 5-4 on the following
page.

It is obviously of great importance to recognize
+ NOTE:
that EDSMAC assumes the stiffness is uniform about the
exterior of the vehicle, and that EDSMAC uses the value
assigned for the FRONT surface.
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Figure 5-4 Vehicle Stiffness dialog, used for editing the current A, B and
KL stiffness coefficients for the current surface. Note that EDSMAC uses
the front side value of KL for the entire vehicle.

To edit the current KL stiffness value:

â In the KL Stiffness field, replace the current value, 58.3, with
the calculated value, 72.4 N/cm .

â Click OK to update the stiffness.
â Click OK again to remove the CG to Front dialog.
The Nissan Sentra is now ready for use in our tutorial. Using the viewer
controls (thumb wheels and manipulators), view the vehicle.
Now, we have both vehicles ready for our study.
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Saving the Case
Now that we’ve created vehicles for our case, let’s save the case file.

â Click on the File menu and choose Save. The Save-as File
Selection dialog is displayed.

you began this case using the EDCRASH Tutorial, your
+ Ifcase
will be saved using the existing filename,
EdcrashTutorial.
If you started this tutorial as a new case, the
+ NOTE:
Save-as dialog is displayed because the case has not
been saved previously, so we need to enter a filename.
Continue with the following steps.

â In the Case Title text field, enter EDSMAC Tutorial,
Visibility Study.

The Case Title is displayed as a heading on all
+ NOTE:
printed output reports.
TUTORIAL

â In the Filename text field, enter EDSMACTutorial.
â Click SAVE. The current case data are saved in the
hve2d/supportFiles/case subdirectory.

Saving the file occasionally is a highly
+ NOTE:
recommended practice.
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Creating the Environment
Now, let’s add the environment:

â Choose Environment Mode. The Environment Editor is
displayed.

â Click on Add New Object. The Environment Information
dialog is displayed.

â Using the Location Database combo box, choose Sydney,
NSW, Australia. The latitude (35.30.00S), longitude
(151.10.00E) and GMT, hours from the prime meridian (+10)
are displayed for the selected location.

If Sydney were not included in your Location
+ NOTE:
Database, you could add it simply by typing in a new
location name, latitude, longitude and GMT.

â Edit

the name
Intersection.

for

the

accident

site,

Blind

â Edit the date and time of the incident we are studying,
7-23-97 and 1330, respectively.

â Edit the angle from true north to the earth-fixed X axis in our
environment, -10 degrees.

The Latitude, Longitude, GMT, Date/Time and
+ NOTE:
angle from true north are used to position the sun in the
scene. This is, of course, important because the sun is
the primary light source for the scene.

â To add the environment geometry file to our case, click on
Open. The Environment Geometry File Selection dialog is
displayed.

â Assure that the Files of Type option is set to HVE Geometry
Files (*.h3d). A list of environment geometry files using the
.h3d file format is displayed in a list box. Double-click on
EdcrashEdsmacTutorial_2D.h3d to choose the environment
file and remove the dialog.

â Press OK.
The selected environment is added to our case and displayed in the
Environment Viewer (see Figure 5-5). Use the viewer thumb wheels to view
the scene.

5 - 10

Creating Events

Tutorial

Creating Events
As mentioned at the outset, this EDSMAC tutorial is an avoidability study in which
visibility plays a key role. With this in mind, we will start simulating the event well
before impact to illustrate the visibility between vehicles, as obstructed by the
building on the southwest corner of the intersection.
To create the event, perform the following steps:

â Choose Event Mode. The Event Editor is displayed.
â Click on Add New Object. The Event Information dialog is
displayed.

â Select Ford Escort 2-Dr Hatchback and Nissan Sentra 4-Dr
from the Active Vehicles list. The vehicles are added to the
Event Humans and Vehicles list.

â Select EDSMAC from the Calculation Method options list.
â Enter a name for the event, Visibility Study.

The name of the calculation method will be
+ NOTE:
appended to the event name, thus the complete event
name will become EDSMAC, Visibility Study.

â Press OK to display the event editor.
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Figure 5-5 Environment used for our EDSMAC tutorial.

EDSMAC

Creating Events

Figure 5-6 Positioning the Ford Escort using the Event Editor. The manipulators can be used
to drag and drop the vehicle into position. Click on the cross-bars to drag the vehicle on the
road surface; click on the circular yellow ribbon to rotate the vehicle about its yaw axis.

Now, we’re ready to set up the event. This step involves placing the vehicles in
the environment and assigning driver controls:

â Select Ford Escort 2-Dr Hatchback from the Event Humans &
Vehicles list.

â Choose Set-up from the menu bar, select Position/Velocity.
The Escort is displayed in its initial position at the earth-fixed
origin.

â Click on the vehicle’s X-Y manipulator (see Figure 5-6), wait
for it to turn bright yellow (indicating it has been selected), and
drag it to its initial position, X=35 m, Y=15 m. Click the yaw
manipulator and rotate it to its heading angle, 180 degrees.

To select the X-Y manipulator, the viewer must be
+ NOTE:
in Pick mode, as indicated by the highlighted arrow in the

upper right corner of the viewer (see Figure 5-6).
Adjust the viewer by dollying back (using the Dolly
+ NOTE:
thumb wheel) until you can see the entire intersection.
Be sure to keep the mouse button depressed
+ NOTE:
while you drag the manipulators.
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Table 5-1 Steer table entries for the Ford Escort.

Time
(sec)

Steer Angle at Steering Wheel
(degrees)

1.50

0.0

2.00

90.0

If you cant position the vehicle at the exact coor+ NOTE:
dinates, simply enter them in the dialog (in fact, its often
easier to directly enter the coordinates using the dialog).
When entering coordinates using the
+ NOTE:
Position/Velocity dialog, remember to press <Enter>;
otherwise, the values will not be assigned.

â Click the Velocity Is Assigned checkbox. Enter the initial total
velocity, 40 km/h, followed by Apply (or simply press
<Enter>).

TUTORIAL

Next, let’s enter the driver controls:

â Choose Set-up from the menu bar, select Driver Controls. The
Driver controls dialog is displayed. The default driver control
table, Steering, is also displayed for editing.

Two Steer Table options are available:
+ NOTE:
At Steering Wheel and At Axle. Well use the default
method, At Steering Wheel.

â Enter the values shown in Table 5-1 into the steer table:
Next, let’s assign the Brake Table for the Ford Escort:

â Click the Brake tab on the Driver Controls dialog. The Brake
dialog is displayed for the Ford Escort.

Two Brake Table options are available: Available
+ NOTE:
Friction and Wheel Force. Well use the default method,
Available Friction.
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Table 5-2 Brake table for Ford Escort.

Time
(sec)

Percent Available Friction (%/100)
R/F

L/F

R/R

L/R

2.25

0.00

0.00

0.00

0.00

2.35

1.00

1.00

1.00

1.00

2.70

1.00

1.00

1.00

1.00

2.80

1.00

1.00

0.01

0.01

Enter the Escort’s brake table using the % Available Friction (default) method:

â Enter the values shown in Table 5-2 into the table:
â Click OK to accept the Ford Escort’s steering and brake tables.
Event set-up for the Ford Escort is now complete. Let’s set up the Nissan
Sentra:

â Select the Nissan Sentra from the Event Humans and Vehicles
list.

â Choose Set-up from the menu bar, select Position/Velocity.
The Nissan is displayed at its initial position at the earth-fixed
origin.

â Click on the vehicle’s X-Y manipulator (see Figure 5-7), wait for

it to turn bright yellow (indicating it has been selected), and drag it
to its initial position, X=3.5 m, Y=39 m. Click the yaw
manipulator and rotate it to its heading angle, -90 degrees.

Be sure to keep the mouse button depressed
+ NOTE:
while you drag the manipulators.
â Click the Velocity is Assigned check box and enter the initial
velocity, 35 km/h, followed by <Enter>.

Remember to press Apply or <Enter>. Otherwise,
+ NOTE:
the value will not be assigned.
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The Nissan’s initial position and velocity are now established. Let’s enter the
driver controls. In this case, there are no driver inputs, per se. However, after
impact the vehicle coasts to rest, so we need to enter rolling resistances:

â Choose Set-up from the menu bar, and select Driver Controls.
The Driver Controls dialog is displayed.

â Click the Brake tab. The Brake Table is displayed.
â Click on the Table Is option list and choose the Available

Friction option.
â Enter the rolling resistances after impact, as shown in Table
5-3, next page.

â Press OK to accept the table.
This event lasts more than 5 seconds. To prevent premature termination, let’s
increase the default maximum simulation time.

â Click on the Options menu and choose Simulation Controls.
The Simulation Controls dialog is displayed.

â Edit the Maximum Simulation Time, changing it from 5 to 10
seconds.

â Press OK to update the simulation controls.
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Figure 5-7 Positioning the Nissan Sentra using the Event Editor. The manipulators can
be used to drag and drop the vehicle into position.
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Table 5-3 Post-impact rolling resistances for the Nissan Sentra.

Time
(sec)

Percent Available Friction (%/100)
R/F

L/F

R/R

L/R

2.70

0.00

0.00

0.00

0.00

2.80

0.20

0.20

0.01

0.01

Now, we’re ready to execute the event.

â Use the viewer controls (thumb wheels, zoom slider and direct
hand-in-viewer manipulator) to set the view similar to that
shown in Figure 5-8.

Next, let’s set up the Key Results windows:

â If Key Results windows are not displayed, choose Show Key
Results from the Options menu.

â Drag the Key Results windows to a convenient location, where
they do not block the view but still allow us access to the
viewer thumb wheel controls (in case we want to change the
view).
Now, we’re ready to execute the event.

â Using the Event Controller, press Play to execute the event.
Watch as the vehicles approach each other, collide, and roll to their rest
positions.

You can adjust the view while the event is
+ NOTE:
executing, or you can press Pause/Stop to temporarily

stop the event while setting the view, then press Play to
continue it.
Remember to pay attention to the Key Results
+ NOTE:
windows; in this case, you might be interested in the
position and velocity of each vehicle at initial visibility.
We have now completed the event.
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Figure 5-8 Overall view of the scene after event set-up is complete.
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Now that we have produced our EDSMAC simulations, let’s take a detailed
look at the results. The Playback Editor is used for reviewing and printing
reports for each event in the current case, as well as for producing video output.
EDSMAC produces the following reports:


Accident History - A table of initial, impact, separation and final
positions and velocities for each vehicle



Damage Data - A table of damage profile coordinates, CDC, PDOF,
Delta-V and Peak Acceleration for each vehicle



DamageProfiles - A 3-D visualization of the damage to each vehicle,
linked to the Playback Controller





Messages - A list of messages produced by the current run
Program Data - A table containing program control information
Trajectory Simulation - A 3-D visualization of the event, displayed
at a user-selectable time interval



VariableOutput - A table containing user-selectable, time-dependent



Vehicle Data - Tables containing all of the vehicle data

simulation results for each vehicle

and driver

control data used by the simulation

To view the output reports, we need to be in Playback mode:

â Choose Playback Mode. The Playback Editor is displayed.
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Report Windows
The reports listed on the previous page are displayed by selecting Report
Windows. Each Report Window contains an individual report.

TUTORIAL

To view the reports produced by the EDSMAC, Visibility Study event, perform
the following steps:

Figure 5-9 Report Window Information
dialog, showing the name of the event(s)
in the current case.

â Choose Playback Mode. The Playback Editor is displayed.
â Click Add New Object. The Report Window Information
dialog is displayed, as shown in Figure 5-9, and includes a list
of the active events (EDSMAC, Visibility Study is the only
event in this tutorial). The Report Window Information dialog
also includes the user-editable Report Window Name text field
and Selected Output option list.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose any of the
available reports.

â Press OK to display the report.
The selected report will be displayed in a resizable window. The following
pages illustrate the reports produced for the EDSMAC, Visibility Study event.
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Accident History
The Accident History report displays the positions and velocities for each
vehicle at key times (Start of Run, Impact, Separation and Final/Rest) during
the run.
To view the Accident History report for the EDSMAC Visibility Study event,
perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Accident
History.

â Press OK.
The Accident History report is displayed for the EDSMAC, Visibility Study
event, as shown in Figure 5-10.

The vehicles are listed in the order in which they
+ NOTE:
were selected when creating the event. This is the same
order in which they appear in the active objects list in the
Event Editor.

Figure 5-10 Accident History Report for EDSMAC, Visibility Study.
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Damage Data
The Damage Data report displays a table of collision vector results for each
vehicle. The collision vectors determine the total force on each vehicle. In
addition, the endpoints of the collision vectors define the damage profile.
The collision vectors are displayed both in cylindrical coordinates (RHO, PSI)
and Cartesian coordinates (x,y).

TUTORIAL

Following the table of collision vectors, the Damage Ranges are displayed.
The Damage Ranges report includes the beginning and ending point for each
damaged region on the exterior (up to 10 regions may be displayed for each
vehicle), followed by the CDC, PDOF, Delta-V and Peak Acceleration for
each damage region.

Figure 5-11 Damage Data Report for EDSMAC, Visibility Study. The two images
show the top and bottom portions of the report which contain important information
about the event.
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To view the Damage Data report for the EDSMAC Visibility Study event,
perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Damage
Data.

â Press OK.
The Damage Data report is displayed for the EDSMAC, Visibility Study event,
as shown in Figure 5-11.
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Figure 5-12 Damage Profile Report for Nissan Sentra in EDSMAC, Visibility Study.

To view the Damage Profiles report produced by the EDSMAC, Visibility
Study event, perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Damage
Profiles.

â Press OK.
With a Trajectory Simulation also open, use the Playback Controller to view
the damage to each vehicle dynamically.
The Damage Profiles simulation for the Nissan Sentra in EDSMAC, Visibility
Study is shown in Figure 5-12.
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The Damage Profiles report provides a visual representation of the damage to
each vehicle. This report is linked to the Playback Controller through the
Trajectory Simulation. Therefore, in order to see any damage in the Damage
Profiles report window, you must first open a Trajectory Simulation for the
event.
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Messages
EDSMAC produces several messages, depending on the outcome of the run.
For a complete list and explanation of these messages, refer to Chapter 6.

Figure 5-13 Messages Report for EDSMAC, Visibility Study.

To view the Messages report produced by the EDSMAC, Visibility Study event,
perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Messages.
â Press OK.
The Messages report for the Nissan Sentra in EDSMAC, Visibility Study is
shown in Figure 5-13.
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Program Data
The Program Data report displays the simulation controls (integration time
steps and termination conditions), collision parameters used by the EDSMAC
collision algorithm and the hard-coded values (RHOB Tests) used to
determine if a vector passes through the end (front or back) or side (left or
right).
To view the Program Data report for the EDSMAC, Visibility Study event,
perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Program
Data.

â Press OK.

TUTORIAL

The Program Data report is displayed for the EDSMAC, Visibility Study event,
as shown in Figure 5-14.

Figure 5-14 Program Data Report for EDSMAC, Visibility Study.
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Trajectory Simulation
The Trajectory Simulation report is a dynamic visualization, much like the
Event mode viewer, controlled by the Event Controller.

A significant difference between the simulation in
+ NOTE:
the Event Editor and the Playback Editor is that no
calculations take place in Playback mode.

To view the Trajectory Simulation for the EDSMAC, Visibility Study event,
perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.
â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Trajectory
Simulation.
â Press OK.

The Trajectory Simulation viewer is displayed for the EDSMAC, Visibility
Study event. The vehicles are shown at their initial positions.
To visualize the motion, perform the following steps:

â Click Play (single right-arrow). The simulation begins and is
displayed at the current Playback output interval.

â Click Pause. The simulation stops.
â Click Reverse (single left-arrow). The simulation plays in
reverse.

â Click Pause. The simulation stops.
â Click Rewind (left arrow with bar). The simulation returns to
the start.

Click Advance to End (right arrow with bar) the simulation advances to the end
of the run.
The Trajectory Simulation for the Nissan Sentra in EDSMAC, Visibility Study
is shown in Figure 5-15.
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Figure 5-15 Trajectory Simulation for EDSMAC, Visibility Study, displaying the crash
sequence at the end of the event.
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Variable Output
The Variable Output table displays all the time-dependent results computed by
EDSMAC. To view the Variable Output report for the EDSMAC, Visibility
Study event, perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Variable
Output.

â Press OK.
The Variable Output report is displayed for the EDSMAC, Visibility Study
event. The next step is to select the time-dependent results we wish to display
in the table.

Variable Selection
The purpose of our EDSMAC study is to evaluate the avoidability of the
accident based on speeds and visibility. To document the path positions as a
function of time, let’s select the position, velocity and acceleration from the
Variable Selection dialog.

â Click on Select Variables in the Variable Output window. The
Variable Selection dialog is displayed, as shown in Figure 5-16
on the following page.
The Object Name option list displays the first vehicle, Ford Escort 2-Dr
Hatchback. The Kinematics output group is the default selection and the
Kinematics Variables list is displayed. Let’s add X, Y, Yaw, Vtotal and Accel
total to the Key Results window:

â Select X, Y, Yaw, V-tot and Acc-tot from the list .
Next, let add the same parameters for the Nissan Sentra:

â Click on the Object Name option list and choose Nissan Sentra
4-Dr. The Kinematics variable list is displayed.

â Select X, Y, Yaw, V-tot and Acc-tot from the list .

NOTE: Feel free to add additional variables to the
+ Variable
Output window.
â Press OK to add the selected variables to the Variable Output
window.
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Figure 5-16 Variable Selection dialog, used for selecting the
results displayed in the Output Report.

The Variable Output report for the EDSMAC, Visibility Study event now
includes position, velocity and acceleration for both vehicles, plus any
other variables you may have added (see Figure 5-17).
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Figure 5-17 Variable Output report for EDSMAC, Visibility Study, displaying the selected
results.
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The Vehicle Data report displays the vehicle data, tire data and driver tables for
each vehicle in the event.

Figure 5-18 Vehicle Data Report for EDSMAC Visibility Study. Only a portion of the report
is displayed. Use the scroll bars to review the remaining report.
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To view the Vehicle Data report for the EDSMAC, Visibility Study event,
perform the following steps:

â Click Add New Object. The Report Window Information
dialog is displayed.

â Select EDSMAC, Visibility Study from the Active Events list.
â Click on the Select Output option list and choose Vehicle Data.
â Press OK.
A portion of the Vehicle Data report is displayed for EDSMAC, Visibility Study
in Figure 5-18.

The Vehicle Data, Damage Data (previous pages)
+ NOTE:
and several other reports contain more information than
fits into the default window size. Use the scroll bars,
resize the dialog, or adjust the font size to view the entire
report.
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Printing
The final step is to print the above reports. Printing reports is simple. All you do
is choose a report and print it. For example:

â Click on the Variable Output - EDSMAC, Visibility Study
report window. The window is highlighted and pops to the top
of the display (if it isn’t there already), indicating it is the
current window.

â Click on the File menu and choose Print. The Print dialog is
displayed, allowing the user to select from several available
print options.

Alternatively, you can click on the print icon in the
+ NOTE:
main menu bar.
â Press OK. The Variable Output report is printed on the system
printer.
That’s all there is to it! You can print any other report using the same three
steps described above.

TUTORIAL

The Print dialog provides several options. Refer to
+ NOTE:
your Windows or printer manual for more information.
For several reports it may be best to print in
+ NOTE:
landscape rather than portrait mode.
The font size of both the printed reports and
+ NOTE:
screen display may be edited by clicking on the Options
menu and choosing Preferences. Use the Font Size
option list to change the size.
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